# Outlook Quick Reference Guide

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>2</td>
</tr>
<tr>
<td>Calendars</td>
<td>2</td>
</tr>
<tr>
<td>Setting Your Work Hours</td>
<td>3</td>
</tr>
<tr>
<td>Displaying Multiple Calendars</td>
<td>4</td>
</tr>
<tr>
<td>Scheduling Assistant</td>
<td>5</td>
</tr>
<tr>
<td>Accepting Meetings</td>
<td>7</td>
</tr>
<tr>
<td>Proposing a new Date and/or Time</td>
<td>7</td>
</tr>
<tr>
<td>Declining Meetings</td>
<td>8</td>
</tr>
<tr>
<td>Email</td>
<td>9</td>
</tr>
<tr>
<td>Quick Access Tool Bar</td>
<td>9</td>
</tr>
<tr>
<td>Customizing the Ribbon</td>
<td>11</td>
</tr>
<tr>
<td>New E-Mail Message</td>
<td>12</td>
</tr>
<tr>
<td>Auto Close upon Reply</td>
<td>12</td>
</tr>
<tr>
<td>Flagging</td>
<td>13</td>
</tr>
<tr>
<td>Search Tool</td>
<td>14</td>
</tr>
<tr>
<td>Business Card as your Signature</td>
<td>15</td>
</tr>
<tr>
<td>Tasks</td>
<td>20</td>
</tr>
</tbody>
</table>
Purpose
This guide is written with the intent not to cover all of Outlook’s many features but to enable the user to quickly grasp a few of the more common features. This is a companion manual to the New Employee Technology Training Guide provided by SCOE’s Information Technology department.

General Shortcuts
Like most Microsoft products, Outlook has its very own shortcut keys

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + R</td>
<td>Reply to email</td>
</tr>
<tr>
<td>Alt + R</td>
<td>Reply to all in email or switch to work week calendar view</td>
</tr>
<tr>
<td>Alt + W</td>
<td>Forward email or switch to weekly calendar view</td>
</tr>
<tr>
<td>Alt + S</td>
<td>Send email</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Open the “Go to Date” dialog to jump to any date in the calendar</td>
</tr>
</tbody>
</table>

Switch between mail, calendar, contacts, and other items in the navigation pane by selecting Ctrl + the appropriate number.

Calendars
Keeping your calendar current assists your coworkers when wanting to schedule a meeting with you. One of the nice features of the calendar is you can use it as a time management tool for yourself if you so desire.
When creating meetings or appointments, the free/busy options include free – perfect for reminders and out of office so viewers know when you are unavailable.

Setting Your Work Hours
Many positions allow the individual to work a variety of work hours depending on the department’s need. To set your work hours within Outlook, select file\options\calendar. Modify the work time section as needed.
Displaying Multiple Calendars

1.) You can open more than one calendar in Outlook and you have the option of looking at them side by side as seen below
2.) The second way you can look at multiple calendars is in overlay view you can do this by selecting the left pointing arrow at the top of each calendar it will turn into a right pointing arrow which is what you would select if you wanted to unstack them.

![Calendar overlay view](image)

**Scheduling Assistant**

By using the Scheduling Assistant you can take a quick peak at your invitee, or invitees, schedule if they have a SCOE email account when creating a meeting.

Rather than populating the **To** line with the email addresses of your invitees, select the **Scheduling Assistant**.

A grid view will appear with the date and hours displayed. Your personal calendar will appear with your own appointments. Select the **Add Attendees** button to launch the global address list.

![Scheduling Assistant](image)
If a room is required, and available, invite the room and it will be scheduled as well. You will receive a confirmation or a declination email from the room calendar.

If your meeting is cancelled or rescheduled, please be considerate to others by cancelling the meeting so the room will be once again available.

Feel free to use the dropdown to access different email lists, including your own contact list.
After I have invited my attendees I can peruse everyone’s schedule to see what will work. There is a legend at the bottom, however, let’s run through it real quick.

- First is my own calendar and commitments
- Sean Salomon does not work for SCOE so that is why his calendar is displaying the diagonal lines designating no information is available
- I have access to James’s calendar which is why I see what times he is busy for and the subject of the meeting.
- I do not have access to Jodie’s calendar so I see her busy times by a solid purple bar

Accepting Meetings

Accepting the meeting, while always polite, is easy to do. The meeting invite can be opened to accept. Once the accept option is selected, you will be provided the option of editing the response before sending, sending the response, or not to send a response at all, but still accept the meeting invitation. The meeting organizer is able to track the invitee’s responses so it is always nice to do. An organizational wide meeting invitation would be a good example of when not to send a response.

If you preview your emails, the options will appear there as well. The same options will appear without even needing to open the original email/invitation.

Proposing a new Date and/or Time

Only the originator can change the time and date of a meeting. However, if you are unable to attend rather than declining the meeting all together you have the option to propose a new meeting date and/or time. If
the number of attendees is too large, it may be best to merely decline; there is no hard and fast rule and is more of an individual judgement call.

Declining Meetings
If the meeting is one you choose not to attend please take the second required to decline it officially rather than simply ignoring the request.
Email

Quick Access Tool Bar
Quick access bars are a fantastic tool and enables you to accomplish many tasks without perusing the ribbons each time you want to perform a function. Outlook has two tool bar sets. The first is the general tool bar and is used on all pages excluding a new email message. The new email message has its own tool bar.

The tool bar can be found in the top left corner. If the quick access bar is empty, a single line with a chevron below it will be just to the right of the Outlook button.

Select the chevron and the customize quick access toolbar will appear.

After the drop down menu appears, select the icons you would like to add or select more commands to receive the entire list. Once you select an icon the drop down will disappear. Continue the selection process until you have all you would like.

The bar will continue to grow as you add more icons.

When selecting the more commands option, you have the options to add or remove icons to the list and to rearrange them on the toolbar.
Icons can be added on the fly as well. When using an icon on the ribbon that you would like to add to the ribbon:

- Hover over the icon until it is highlighted
- Right click your mouse
- When the popup menu appears, select *Add to Quick Access Toolbar*

### Toolbar Favorites

<table>
<thead>
<tr>
<th>General Toolbar Icons</th>
<th>Email Toolbar Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
</tr>
</tbody>
</table>

| 1 | Send/receive all folders | 1 | Undo |
| 2 | New email               | 2 | Redo |
| 3 | New Meeting             | 3 | Previous Item (navigate within mail) |
| 4 | Undo                    | 4 | Next Item (navigate within mail) |
| 5 | Print                   | 5 | Print Preview |
|   |                         | 6 | Quick Print |
|   |                         | 7 | Spelling and Grammar Check |
Customizing the Ribbon
The ribbon by far is the number one new feature in Office 2010 and now they allow you complete control over what is on your ribbon.

1.) From the File tab select Options

2.) In the window below you can personalize your ribbon.
New E-Mail Message

1.) From the **Message Tab** just above the ribbon you will find the following features: clipboard, Basic Text formatting, Names, Include and Tags.

2.) From the **Options tab** in email you can show the BCC and the From Field, under permissions not allow the email you are sending to be forwarded, you can track a message, or you can delay delivery.

3.) From the **Format Text Tab** you can change the Font, Format, Paragraph, Style

**Auto Close upon Reply**
This feature allows you to have the message you replied to close after you send the reply. How to configure the Auto Close Feature:

1.) Click on the **File** tab then select **Options**.
2.) Select **Mail** on the left hand column and then use the scroll bar on the right to go about half way down to the **Replies and forwards heading**. Select the check box next to **Close Original message window when replying or forwarding**.

![Outlook Options](image)

**Flagging**

Flagging a message can be used in several different ways, you can either flag a message while you are composing it or you can flag a message that you received in your inbox.

How to flag a message an outgoing message:

1.) Click on the **Follow up** flag in the Tags section of a New Message

   a. Select the type of flag you want to insert Today, Tomorrow, This week, Next week when you have selected the type of flag it will place a message below the ribbon as to what actions Outlook is going to take with that message.
b. If you select custom it will bring up the following dialog box here you will have the option to not only flag the message for yourself but to flag it for the recipient of the message.

Creating Rules
Rules are extremely helpful in identifying junk or categorizing emails. The easiest way to create a rule is to be sitting on whatever you want to make a rule for (awful description I realize)

Search Tool
1.) When you click the search field it will display a new tab search
2.) If you click on the **Search Tools** you will find the **Advanced Find**

3.) In the Advanced Find window you can search for a message many different ways

---

**Business Card as your Signature**

Adding a business card in the signature of your email:

1.) Open the contact with your name on it if you don’t have one you need to create a contact with all of the information that you want your contacts to have. When you have completed that you will need to click on the Business Card in the Options part of the Ribbon.
2.) The Edit Business Card dialog box will come up, in the **Fields section** you can arrange the fields the way you want your business card to look if you grab the image from the `\file0\ScoeShare\1 Outlook Tips and Tricks` you can click **Change** next to Image.
3.) Select the **File** tab and then select **Options**

4.) From the Outlook Options menu select the **Mail**
5.) Select **New**

![Image of Signature Editor]

6.) Name your New Signature, I suggest your name with the words Business Card after it and click OK.

![Image of New Signature Dialog Box]

Type a name for this signature:

**Kendell's Business Card**

OK  |  Cancel
7.) Select Business Card

8.) From your contacts find your name, you should see the business card you made in the bottom part of the screen, click OK.
9.) In the Signatures and Stationary Dialog box select the name of your new business card in the **New Messages** drop down and in the **Replies/forwards**

![Signatures and Stationary Dialog box](image)

**Tasks**
Every job requires tasks and Outlook helps you organize them so that you can keep ahead of your deadline, it also allows you to assign a task to someone else.

1.) Click on **Tasks** it is located in the bottom left hand corner of your outlook Navigation Pane

![Tasks in Navigation Pane](image)

2.) First you want to add a new task by clicking **New Task**
3.) The new untitled task has a lot of features some of them I recommend adding are:
   a. The subject
   b. Select a Start Date
   c. Select a Due Date
   d. Reminder

4.) The other feature of a task is that you can assign a task to another user; by clicking the **Assign Task** under Manage Task portion of the ribbon you will get the following dialog box.